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Video Editing

From Beginner to Professional in a Few Easy Steps   

Video Editing Video editing means the cutting, trimming and rearrangement of
existing clips. 

Sticking clips together, or ’hard cuts’ as they are known, is by no means
the only possibility in video editing. Imaginative and effective transitions
allow smooth and varied passage from one clip to another. 

There are ready-made transitions already integrated into MoviePack
but, if you prefer, you can design and create your own transitions with
a few clicks of the mouse.
Manual Tutorial Reference Effects
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Our AimIn this booklet you will learn how to: 

● Position movie clips

● Cut and trim movie clips

● Insert ready-made transitions between two clips

The results can be achieved in a few basic steps.

I Please read the ’Tutorial - The Interface’ booklet before
beginning ’Tutorial - Video Editing’ as the MoviePack
interface described therein is needed for the following
tutorial. 

A new animation is also needed in the Canvas window.

Creating a New Animation u Close any existing animations with the Close command on the
File menu (shortcut Ctrl+F4).

Save the animation under a suitable name in a suitable folder. 

Each new animation has to be set up properly. The size of the animation
should be 320 x 240 pixels with 25 frames per second set against a
white background. 

u Click on the  New Animation icon in the MoviePack icon
bar.

u In the Animation Setup dialog box select PAL (or NTSC) in the Time
tab.

u In the Page tab select Size Multimedia Medium, 320 x 240. 

u Click  Background Color.

u In the Choose Color dialog box set the Brightness slider to 100 in
HSB or in the chromaticity diagram drag the small slider to
the white area.

I In the Schemes tab you can save the settings under ’PAL-
Medium-White’ and then all new animations will be loaded
with these settings in future. 

Adjust the new Canvas, ’Animation x’, to full size by dragging the corners
of the window with the mouse.
Video Editing
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I It is even easier to create a new animation by loading the
’Tut_1152x864.M3W’ project from the ’Samples’ folder.

u From the File menu, select the Open Project command.

u In the Open Project dialog box, select the ’Samples’ folder and
then the ’Tut_1152x864.M3W’ project.

Inserting Movie Clips

Clips (Movie Clip) which are to be inserted
into an animation can be found in the
’Samples’ folder. The Browser has already
been prepared.

u In the Browser activate the Movie
Clip [Samples] folder.

u Click ’3d_1.avi’ and drag it
into the Video A track in the
Timeline so that the left-hand
side of the black object bar
begins at 0:00:00:00.  

Tut_Editing_Timeline_007_E.
tif 
Tut_Editing_Timeline_007_G.
TIF
Tut_Editing_001.m3w 
Manual Tutorial Reference Effects
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I During video editing, clips are inserted into the Video A or
Video B track. Transitions are inserted into the Transitions track. 

The first clip has been inserted.  

} Timeslider

Time Display

Editing area

Zoom buttons in the Timeline 
Inserting Movie Clips
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Scale in the Timeline  If the clip is not visible in its entirety in the Timeline, the scale needs to be
altered.

u Click the zoom key in the Timeline and select a
different scale from the context menu, e.g. 1s.

I ’1f’ denotes 1 frame, ’1s’ denotes 1 second and ’1 min’
denotes 1 minute per display unit. 

The scale has been altered. If the clip is still not completely visible, select
another scale.

If the clip in the Timeline is too far to the right or the left, the display area
can be altered.

u Click anywhere in the Timeline (the pointer will
transform into a hand symbol) and then move the
display to the right or left using the mouse until the
clip is displayed in its entirety.  

Moving the Timeslider  In the Canvas, the Effect Box and in the Preview the first frame of the clip is
visible because the Timeslider in the Timeline, a vertical pointer, is
positioned on 0:00:00:00.

The Timeslider can be moved. 

u Either click on a certain position in the time scale in the
Timeline or 

u Click on the triangle at the top of the Timeslider and drag it
to the left or right. 

The pointer not only automatically moves to the desired time in the
Timeline, the relevant frame of the clip is also visible in the Canvas, Preview
and Effect Box.

There are other ways to move the time either 1 frame forwards or
backwards, and to the beginning or end of the Preview:

u Either click the  buttons in the Timeline.

or

u Click the  buttons in the Preview.

Tut_Editing_001_E.tif 
Tut_Editing.m3w 

Time scale

Timeslider
Manual Tutorial Reference Effects
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The Timeslider will then either move to the next/previous frame, or to
the beginning/end of the preview.

Entering Time Numerically  The time can be altered in the Time Displays of the Timeline, Preview and
Effect Box numerically using the keyboard.

u Click a digit in the time display and enter the digits you want.
Press Enter to finish.

The selected digit blinks first then the other digits can be entered one
after the other. Please note:

I The numerical keyboard does not work in MoviePack, please
use the alphanumerical keys on your keyboard.

I The entry 1:34:56:12 denotes:
1hour, 34 minutes, 56 seconds, 12 frames.

Reset the time in the Timeline to 0:00:00:00 (the first frame of the
animation) and then move it forward frame by frame. Count the frames
and observe the transition to the following seconds.

I If an animation has, for example, 25 frames per second, the
first frame will be shown at 0:00:00:00, the 25th frame will
be shown at 0:00:00:24, the 26th at 0:00:01:00, etc.

If you are working with a wheel mouse (the middle button is a wheel),
you can also use this to set the Timeslider.

u Click on the Timeline.

u Move the mouse wheel back and forth.

The Timeslider moves forwards and backwards, frame by frame, even
if the pointer is no longer visible in the Timeline.

Activating the Preview  The clip can be viewed in the Preview.

u Click Play  in the Preview.

It is standard to see the first 3 seconds of the clip at the beginning. The
Timeslider in the Preview moves in synchronization with the sequence of
the frames. The Play button then changes into the Stop button, which stops

Play Stop
Inserting Movie Clips
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the Preview on the present frame. The Timeslider in the preview can be
moved using the mouse whether the Preview is activated or not. 

Modifying the Preview 
Area  

The beginning and end points of the Preview (i.e. its length) are
controlled by setting the preview area, denoted by a green bar in the
Timeline time scale. With each new animation it is set to the first 3
seconds. It can be quickly set to the entire length of the animation: 

u In the Timeline double-click the preview area (green bar) in the
time scale.   

The preview area adapts itself to the entire length of the clip and the
animation can now be seen in its entirety in the Preview.

I Another double-click shortens the preview area to its
previous length and position.

The preview area can be moved to show another part of the clip or
animation in the Preview.

u Position your pointer over the preview area in the Timeline.

The pointer (hand or arrow) transforms into the icon shown
on the left and the preview area can be moved from side to
side.  

u In the Timeline position the pointer over the beginning or end
of the preview area. 

Preview Area

Tut_Editing_Timeline_001_G.ti
f
Tut_Editing_001.m3w 
Manual Tutorial Reference Effects
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The pointer (hand or arrow) transforms into the icon shown
on the left. The beginning or end of the preview area can be
moved to the right or the left and the length of the Preview
changes accordingly. The end of the preview can be moved
to the left past the present beginning to become the new
beginning. 

Trimming and Cutting ClipsMovie clips can be trimmed and cut. 

I Trimming divides the clip into two sections, only one of which
will be used for the animation. 

I Cutting also divides the clip into two sections but both
sections will be used as separate clips in the animation. 

For our example, we are only going to use the middle part of the clip,
the beginning and end are going to be trimmed. 

u Click the left Trim to Beginning  button in the icon bar of the
Timeline. 

u Position the pointer over the clip in the Timeline. 

The pointer transforms into a trim icon (see left). A vertical
line shows exactly where the clip is to be trimmed in the time
scale.  

u Click clip at 0:00:01:00. 

The beginning of the clip is trimmed and the right-hand section remains
in the Timeline.

Left and right Trim button

Tut_Editing_Timeline_002_G.
tif 
Tut_Editing_002.m3w 
Inserting Movie Clips
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The end of the clip can be trimmed in the same way:

u In the icon bar of the Timeline, click the right  Trim to End
button. 

u Position the pointer over the clip in the Timeline. 

The pointer transforms into a trim icon again.  

u Trim from 0:00:08:00 until the end of the clip using the
mouse. 

The end of the clip has been trimmed and the left-hand section remains
in the Timeline.

If you want to divide the clip, so that all the sections of the
clip can be used, select the middle Cutting button. After
cutting, each section can be used separately as an individual
clip.  

I The original objects stored on the hard disk are not changed
by the manipulations (moving, scaling, trimming, ... ). The
files remain intact. 

Clicking the first icon on the icon bar  ends the trim or cutting mode
and the pointer returns to normal. 

Moving Clips In the animation, the clip which has been trimmed should begin at
0:00:00:00. The clip must now be moved:

u In the Timeline position the pointer over the clip in the Video A
track.

The pointer transforms from a hand into the icon on the left.  

u Drag the clip to the left until the beginning is at 0:00:00:00. 

Vertical lines at the beginning and end of the clip facilitate both the
temporal positioning of the clip and orientation if other clips are being
used. 
Manual Tutorial Reference Effects
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Second Clip We will now insert a second clip from the open folder Movie Clip [Samples]
from the Browser into the animation:

u Click the clip ’3d_11.avi’ and drag it into the Video B track in
the Timeline so that the left-hand side of the black object bar
begins at 0:00:05:00. 

Now set the preview area between 0:00:04:00 and 0:00:08:00 so
that 3 seconds of the clip in Video A track and 1 second of the clip in
Video B track can be seen. Between both clips is a hard cut at
0:00:07:00. The first two seconds of the bottom clip, Video B, cannot be
seen, as they are hidden by the top clip, Video A. 

I In the animation, only the frames which are not hidden by
overlying clips are visible.

Naming Tracks Each track can be given a suitable name:

u Double-click the name Video A in the Timeline and enter another
name, e.g. Butterfly.

u Double-click the name Video B in the Timeline and enter another
name, e.g. Flower.  

Ico_MovieClip_0
01.tif 

Tut_Editing_Timeline_003_G.
tif 
Tut_Editing_002.m3w 

Tut_Editing_Timeline_004_G.
tif 
Tut_Editing_002.m3w 

The names of the tracks can be altered, Video B is being edi-
ted
Inserting Movie Clips
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In the following instructions and illustrations the names Video A and Video
B will be retained for simplicity’s sake.

Transitions 

Transitions  A transition is the passage between 2 video tracks, i.e. Video A is
replaced by Video B, or vice-versa. The most common transition between
two scenes in videos is the hard cut. No doubt you know other methods
of transition, such as soft blend, fade in and fade out. 

During the so-called soft blend, two overlapping clips are visible to
varying extents for a short time between (0.5 and 2 seconds). The
frames of the clip being faded out disappear slowly in order to make
room for the frames of the coming clip.

Innumerable transitions can be created, saved and reused in
MoviePack. 

Some pre-made transitions are automatically copied to the 'Transitions'
folder (sub-folder of MoviePack) during installation.

Inserting Transitions Inserting transitions is just as easy as inserting clips:

u In the Browser click Generated Transition [PAL Transitions] or
Generated Transition [NTSC Transitions]. 

u Double-click the 3D FX folder. 

u In the Generated Transition [3dfx] folder click 'WaterDrop.M3T'
and drag it into the Transition track in the Timeline so that it lies
Manual Tutorial Reference Effects
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between the end of the top clip and the beginning of the
bottom one. 

The transition ’WaterDrop.M3T’ automatically adjusts itself to the length
of the overlapping area between the Video A and Video B tracks (2
seconds).

I If the wrong transition or object is selected from the Browser,
it can be deleted immediately using the Del key. Naturally, the
files on the hard disk remain unchanged.

Preview Set the preview area from 0:00:04:00 to 0:00:08:00. You will see this
section of the animation in the Preview and you can judge the results of
your creativity.

We see the ’fluttering butterfly’ for 1 second, then a 2 second soft blend
and finally the ’pulsating flower’. To see the whole animation in the
Preview the preview area must be adjusted to the length of the animation. 

u Double-click the preview area.

The area expands from 0:00:00:00 to 0:00:12:11. The animation is
shown in its entirety in the Preview. 

I Repeated double-clicking in the preview area alternates
between the overall and partial Preview.

Transitions in the Effect 
Box  

If you want to view a transition separately as an individual object in the
Effect Box, the Timeslider has to be positioned on the transition and the
transition must be activated. 

u Click the transition track in the Timeline.
Transitions
Video Editing TUT 15Manual Tutorial Reference Effects
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The diagonal lines surrounding the ’WaterDrop’ bar in the Timeline

signal that this transition is now activated. The transition is shown in the

Effect Box. 

The two clips to which the transition is going to be applied are
represented by the letters ’A’ and ’B’ .

Position the Timeslider over the
beginning, middle and end of
the scale and you will see how
’A’ gradually and smoothly
merges into ’B’. 
  

 

Transitions in the Preview  The transition can be previewed quickly:

u Double-click the transition in the Timeline.

MoviePack switches from animation mode to transition mode. The
transitions can be edited and observed.

u Click Play  in the Preview window. 

The transition from one clip to another is very clearly displayed in the
Preview by the two letters. 

Tut_Editing_Effektbox_001_E
.tif
Tut_Transition_WaterDrop_00
1_X.tif .... 004_X.tif 
Tut_Editing_004.m3w 
Manual Tutorial Reference Effects
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Transition Mode and Ani-
mation Mode  

Alternately activating the animation window and then the transition
window allows us to switch from one mode to the other. 

To end the transition mode:

u From the File menu in the transition mode, select the Close
command.

u In the transition window, click on Close Window (above
right). 

We have now quit transition mode, any changes made to the transition
can be saved (but not now).

ï In the next booklet, ’Tutorial - Transitions’, you will learn how
to create transitions and how to alter existing ones.

Undo and Redo  You can now experiment with your new-found knowledge and observe
the results of the changes in the Preview. Take it one step at a time. If you
make a mistake you can easily undo the last step or redo what you have
just undone.

u From the Edit menu select Undo (shortcut Ctrl + Z).

The last action has been undone.

u From the Edit menu select Redo (shortcut Ctrl + Y).

The undone action has been redone.

One Last Glance To conclude, let’s take one last inquisitive look at the present state of the
animation. 

In the Timeline, the Timeslider is positioned at 0:00:06:11 and the clip
'3d_1.avi' has been activated. In the Canvas the two clips of the
animation are overlapped and both are visible through the transition,
while in the Effect Box the activated clip '3d_1.avi' appears unaffected.
The complete animation is running in the Preview.

I The Preview window is designed to show changes to short
sections of the animation immediately. Longer clips should be
previewed in the Video Control window.

Tut_Edit_001_E.tif 
Transitions
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This animation is saved in ’Samples’ under ’Tut_Editing.m3’,
the project is saved under ’Tut_Editing.m3w’.  

 

Unlimited Transitions and Clips 

In the same way as you positioned the two video clips in the Video A and
Video B tracks respectively and inserted a fantastic transition between
them, it is also possible to place several clips one after the other in each
track and insert the same, similar or completely different transitions
between them.

Tut_Editing.m3 
Tut_Editing.m3w 
Manual Tutorial Reference Effects
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I Transitions can only be inserted into the Transition track, while
movie clips and still images are inserted into the Video A and
Video B tracks during video editing.

Several Transitions Additional transitions can be inserted into the existing animation.

u Set the scale in the Timeline to  .

u Take a clip from Movie Clip [Samples] and drag it into the Video
A track so that it begins about 2 seconds before the end of
the clip in the Video B track.

u Drag a transition from Generated Transition [Transitions] between
the beginning of the third clip and the end of the second clip. 

u Take a clip from Movie Clip [Samples] and drag it into the Video
B track so that it begins about 2 seconds before the end of
the clip in the Video A track.

u Drag a transition from Generated Transition [Transitions] between
the beginning of the fourth clip and the end of the third. 

The four clips and three transitions which have now been inserted into
the editing area of the Timeline are sufficient as an example. Now you
can handle clips and transitions with ease. The individual changes can
be seen in the Preview and are also represented in the Effect Box as
parameter changes. 

Tut_Editing_Timeline_005_G.
tif 
Tut_Editing_005.m3w 
Unlimited Transitions and Clips
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Practice Makes Perfect  Now it is up to you to search your MoviePack CD or your private
archives for suitable movie clips to be trimmed, cut and spiced up with
fantastic transitions. You will learn video editing intuitively with
MoviePack and you will see just how easily superb animations can be
created. 

ï ’No-one is born a master!’

L:\moviepack\ 
comic_framy03.tif
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